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Purpose
The purpose of this directive is to inform social services districts, voluntary
authorized agencies and Indian tribes with a State/Tribal agreement of the newly
enacted standards and procedures for the approval of an authorized agency by the
Office of Children and Family Services (OCFS) to operate a supervised
independent living program (SILP programs) for foster children. The directive
will address both the transition of existing supervised independent living units
certified by OCFS to supervised independent living units certified by approved
SILP programs operated by authorized agencies and the establishment of new
SILP programs and units.

II.

Background
On January 29, 2008, OCFS filed for final adoption regulations that implemented
changes in state statute relating to the creation and operation of SILP programs.
Chapter 160 of the Laws of 2004 amended the Social Services Law (SSL) to
permit an authorized agency approved by OCFS to operate a SILP program in
accordance with the regulations of OCFS. A SILP program is defined in section
371(21) of the SSL to “mean one or more of a type of agency boarding home
operated and certified by an authorized agency in accordance with the regulations
of the Office of Children and Family Services to provide a transitional experience
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for older youth who, based upon their circumstances, are appropriate for transition
to the level of care and supervision provided in the program.” The statute also
provides that each SILP program must be located “in the community separate
from any of the agency’s other congregate dwellings.”
The above referenced regulations filed by OCFS were effective on February 13,
2008. They have the impact that OCFS will no longer issue agency boarding
home operating certificates for supervised independent living units. Individual
apartments or homes which house foster children will now be certified as
supervised independent living units by OCFS-approved SILP programs operated
by authorized agencies. A supervised independent living unit is defined in 18
NYCRR 449.1(e) to mean a home or apartment certified in accordance with 18
NYCRR Part 449 by an authorized agency approved by OCFS to operate a SILP
program “for the care of up to four youth including their children.” In addition to
applicable definitions, the OCFS regulations set forth standards relating to:
conditions and approval of a SILP program, conditions for the operation of a SILP
program, requirements for each supervised independent living unit, notification of
municipalities of the intent to open a supervised independent living unit, required
documentation, waiver of regulatory standards, and discontinuance of SILP
programs.
As noted, there are supervised independent living programs that have a current
operating certificate issued by OCFS. The directive will address the process for
the conversion of such programs to conform with the standards in OCFS
regulations 18 NYCRR Part 449.
III.

Program Implications
Authorized agencies that desire to operate a SILP program, including those that
currently have a supervised independent living unit certified by OCFS, must apply
to the appropriate OCFS Regional Office, on the forms prescribed by OCFS, for
authorization to operate a SILP program.
Authorized agencies, regardless of whether they are initiating a SILP program or
currently operate an OCFS-certified supervised independent living unit, will be
required to complete an application and provide the following information:
A description of the need for the program, and a list of the social
services districts interested in using the program, including letters of
support from all districts that intend to use the proposed program;
A description of the services that will be provided, including a plan
setting forth how the services will be provided;
The population to be served;
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Proposed staffing, including the proposed staff-to-youth ratio for the
program and the procedures for obtaining background checks on
prospective employees, volunteers or consultants;
A description of how units will be located and certified;
A certification that all supervised independent living units will be
operated in compliance with 18 NYCRR Part 449;
Fiscal material required by OCFS; and
Any other information required by OCFS.

Upon receiving a letter of approval from OCFS to operate a SILP program, an
authorized agency will have authority to certify new and existing individual
homes or apartments, in accordance with 18 NYCRR Part 449. A sample copy of
the OCFS approval letter is attached to this directive for future reference.
Though OCFS will no longer issue operating certificates for supervised
independent living units, an authorized agency approved by OCFS to operate
SILP programs will be responsible: to enter information for each unit (facility) it
certifies into CONNECTIONS; and to separately submit such facility information
to the OCFS Regional Office, and to the OCFS Rate Setting Unit, on forms
prescribed by OCFS.
For authorized agencies currently operating SILP programs under the previous
licensing framework, OCFS will continue to maintain existing operating
certificates for individual supervised independent living units until the authorized
agency is approved to operate SILP programs. For example, if a site is due for a
fire safety inspection and the authorized agency has made application but has not
yet received approval from OCFS to certify supervised independent living units,
OCFS will conduct the fire safety inspection. Authorized agencies, not OCFS,
will be responsible for the inspection, monitoring and supervision of all the
supervised independent living units certified and operated by the agency,
following OCFS’s approval for that agency to operate SILP programs.
A supervised independent living program and each independent living unit remain
subject to the inspection, supervision and enforcement powers of OCFS as set
forth in Article 7 of the SSL.
Local districts wanting to know if authorized agencies are certified by OCFS to
operate supervised independent units are encouraged to contact the appropriate
OCFS Regional Office for confirmation.
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Fiscal Implications
OCFS will continue to establish Maximum State Aid Rates (MSARs) for SILP
programs, and such rates will continue to be “flat rates” that vary by region,
program type and facility size. Rate-related program types currently issued for
SILP programs are double occupancy, triple occupancy, four-bed mother/child
and five-bed mother/child SILP programs (note: A waiver pursuant to 18 NYCRR
449.7 is required to operate a SILP unit with a capacity of five). The SILP rate is
designed to cover social services and case planning activities in addition to basic
care and maintenance associated with the SILP unit, primarily food, clothing,
shelter and supplies. Rate information applicable to SILP programs and units is
available at the following OCFS Internet site under the section labeled Supervised
Independent Living Programs:
http://www.ocfs.state.ny.us/main/rates/FosterCare/Rates/
MSARs for SILP programs are published annually to social services districts and
voluntary agencies through an Administrative Directive, and such rates are posted
and updated, as needed, to the Internet site address specified above. In addition,
the applicable MSAR for each SILP unit is transmitted to the Benefit Issuance
and Control System (BICS) to support local district payment and reimbursement
activities for youth placed in such SILP units.
Pursuant to section 398-a(2-a) of the SSL, social services districts are required to
pay no less than 100 percent of each OCFS-established SILP rate, the same as for
all other congregate care rates (see 05-OCFS-ADM-04 for the details of such
requirements). In addition, all reimbursement formulas in effect for other OCFSapproved foster care programs operated by authorized agencies will be applicable
to OCFS-approved SILP programs operated by authorized agencies under Chapter
160 of the Laws of 2004.
Once an authorized agency is approved to operate a SILP program, the agency is
required to notify the OCFS Regional Office of each SILP unit that it certifies.
The agency is also required to enter and maintain changes to individual SILP
units in CONNECTIONS. Following notification of an additional SILP unit, or
of any change to a SILP unit, the OCFS Rate Setting Unit will enter into
CONNECTIONS the appropriate Rate Code for that SILP unit (authorized
agencies cannot enter Rate Code information in CONNECTIONS). Once the
OCFS Rate Setting Unit assigns a Rate Code to a SILP unit, the MSAR rate
record with the applicable rate will be transmitted to BICS to support payment
and reimbursement activities.
Payments by local districts to authorized agencies for placements in SILP units,
and OCFS reimbursement to local districts for such placements, will require that
authorized agencies with approved SILP programs make the necessary SILP unit
entries to CONNECTIONS. In addition, authorized agencies must notify the
OCFS Regional Office and the OCFS Rate Setting Unit of such entries on the
forms prescribed by OCFS for submitting such information.
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Required Actions
1. Authorized agencies that currently operate a supervised independent living unit
must contact the appropriate OCFS Regional Office to obtain the required forms
to apply for authorization to operate a SILP program and certify supervised
independent living unit(s).
2. Upon receiving written approval from OCFS to operate a SILP program, the
authorized agency must conduct a review of the individual supervised
independent living unit(s) currently operated by the agency, in accordance with
the requirements established in 18 NYCRR 449.4, and where appropriate, certify
the supervised independent living unit(s). At the point that the SILP program is
ready to certify the supervised independent living unit currently certified by
OCFS, the SILP program will be asked to surrender the operating certificate
issued by OCFS for such unit. If the authorized agency determines that a
currently operated supervised independent living unit cannot be certified in
accordance with 18 NYCRR Part 449, the authorized agency must notify the
applicable OCFS Regional Office and surrender the current operating certificate
for such unit.
3. Authorized agencies with approved SILP programs are required to enter facility
record information to CONNECTIONS, and to maintain changes to facility
records in CONNECTIONS for each of its SILP units (see the section below on
Systems Implications).
4. Authorized agencies must re-evaluate and renew the certification of each
supervised independent living unit on an annual basis in accordance with 18
NYCRR Part 449. This evaluation must be documented in the authorized
agency’s record.
5. Authorized agencies must inspect, monitor and supervise each supervised
independent living unit certified by the agency in accordance with 18 NYCRR
Part 449.
6. Authorized agencies must notify OCFS within 10 days, on the forms prescribed
by the OCFS Regional Office, of the certification of a newly established home or
apartment as a supervised independent living unit, any changes to that unit (e.g.,
program name, program type, capacity, address), and the renewal of certification
or closure of an existing supervised independent living unit.

VI.

Systems Implications
Once an authorized agency has received OCFS approval to operate SILP
programs, and the authorized agency has certified the individual units per OCFS
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regulations 18 NYCRR Part 449, such agency must create and maintain individual
SILP units in CONNECTIONS.
Authorized agencies can refer to the SILP job aid posted on the CONNECTIONS
Intranet for step-by-step instructions.
As an overview:
Authorized agency workers with the MAINT FAD business function assigned by
their security coordinator can now create and maintain SILP units in
CONNECTIONS via the toolbar, selecting Options and F/A Home Search and
completing the steps outlined in the job aid. SILPs established by authorized
agency staff are distinguished by both the Level of Care and Program type of
“Supervised Independent Living Program.”
Authorized agency staff cannot certify and maintain other types of congregate
care in CONNECTIONS.
Vendor IDs for new SILP units will be assigned by the authorized agency from
lists provided to the agency by OCFS. Existing SILP units will retain their current
Vendor IDs.
It is the responsibility of the authorized agency to certify and maintain SILP units
in CONNECTIONS; however, OCFS Regional Office staff will also retain this
ability in order to support transition of existing programs.
SILP units that are currently under the “Primary” responsibility of an OCFS
Regional Office and “Secondary” responsibility of OCFS Home Office staff will
need to be reassigned to authorized agency staff as “Primary” responsibility, with
“Secondary” responsibility to the OCFS Regional Office.
This handoff of responsibility will occur after the authorized agency
receives OCFS approval to operate a SILP program and the individual supervised
independent living unit has been certified by the authorized agency.
Any congregate care facility with a Facility Type / Level of Care of “Agency
Boarding Home” and Program type of “SILP” prior to the implementation of
Build 18.9 in December 2006 was converted to the Facility Type / Level of Care
“Supervised Independent Living Program” at that time.
Once the individual SILP units have been entered into CONNECTIONS and are
the “Primary” responsibility of the authorized agency, any changes to or closure
of an existing SILP must be entered into CONNECIONS by the authorized
agency with notification to the OCFS Regional Office.
Annual recertification of SILP units is conducted off-line by the authorized
agency and is not reflected in the CONNECTIONS record.
7
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SILP unit certificates or approval letters are issued off-line by the authorized
agency and are not generated from CONNECTIONS.
VII.

Additional Information
Summary of the new regulations established in 18 NYCRR Part 449 (Supervised
Independent Living Programs)
The regulations create a new Part dedicated exclusively to the creation, approval
and operation of SILP programs and supervised independent living units.
Section 449.1 (Definitions)
The regulations establish definitions of: authorized agency, OCFS, supervised
independent living program authorization, supervised independent living
program, supervised independent living unit, supervised independent living
program certification, youth and adult permanency resource.
Section 449.2 (Conditions for Application and Approval of a Supervised
Independent Living Program)
The regulations establish standards an authorized agency must follow to apply to
OCFS for approval to operate a SILP program.
Section 449.3 (Conditions for Operation of a Supervised Independent Living
Program)
The regulations establish standards for the operation of a SILP program by an
authorized agency approved by OCFS. These standards include the responsibility
of the authorized agency to inspect, monitor and supervise all supervised
independent living units operated by the authorized agency.
The regulations also establish standards for the supervision of youth cared for in
supervised independent living units and the frequency and purpose of visitation of
youth in such units. The regulations establish reporting requirements to OCFS by
the authorized agency relating to the operation of supervised independent living
units.
Section 449.4 (Requirements for Each Supervised Independent Living Unit)
The regulations establish personnel, physical plant and services standards, along
with other conditions for participation in SILP programs. The personnel standards
include criteria for background checks of prospective employees of the SILP
program. The physical plant standards address fire safety, sanitation and other
living condition related standards. The proposed regulations establish what
services must be provided by the SILP program to foster children cared for in a
supervised independent living unit that are intended to provide youth with
opportunities to achieve positive outcomes and make successful transitions to
self-sufficiency. Additional conditions relate to eligibility for a foster child to
participate in a SILP program, the limitations on the capacity of supervised
8
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independent living units, compliance with other state and local laws and
ordinances and standards relating to the education, health and clothing needs of
the foster child.
Section 449.5 (Notification of Municipality)
The regulations set forth the requirement for the authorized agency to notify
municipalities of plans to open supervised independent living units.
Section 449.6 (Required Documentation)
The regulations establish record retention standards for SILP programs. In
addition, the regulations establish record keeping standards for youth cared for in
such programs.
Section 449.7 (Waivers)
The regulations establish the authority and procedures for OCFS to grant waivers
of regulatory standards to authorized agencies for the operation of SILP programs
and units.
449.8 (Discontinuance)
The regulations impose a requirement on an authorized agency to give 90 days
prior written notice to OCFS of the intent to discontinue a SILP program.
VIII. Effective Date
The above referenced regulations filed by OCFS were effective on February 13,
2008. Therefore, the provisions contained in this administrative directive are
effective immediately. Those authorized agencies that desire to operate new SILP
programs and units must apply to the appropriate OCFS regional office
immediately upon receipt of this administrative directive. Those authorized
agencies that currently have an operating certificate issued by OCFS for SILP
programs and units must submit the necessary forms prescribed by OCFS and
attached to this directive, in accordance with OCFS regulations 18 NYCRR Part
449, within 30 days from issuance of this directive.

/s/ Laura M. Velez
Issued By:
Name: Laura M. Velez
Title: Acting Deputy Commissioner
Division/Office: Child Welfare and Community Services
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DATE:
AGENCY:
ADDRESS:
CITY:

Dear

STATE:

ZIP:

;

The purpose of this letter is to inform you that the New York State Office of Children
and Family Services (OCFS) is authorizing
to operate a Supervised Independent Living Program (SILP).
Chapter 160 of the Laws of 2004 amended the Social Services Law (SSL) to permit
an authorized agency approved by OCFS to operate Supervised Independent Living
Programs (SILPs) in accordance with the regulation of OCFS. With this approval,
agency now has the authority to certify
new and existing individual homes or apartments, in accordance with 18 NYCRR Part
449, as supervised independent living units for occupancy by youth at these specific
sites. A supervised independent living unit is defined in 18 NYCRR 449.1(e) to mean “a
home or apartment certified in accordance with 18 NYCRR Part 449 by an authorized
agency approved by OCFS to operate a SILP program “for the care of up to four youth
including their children”.
Please note that your agency must notify OCFS within 10 days, on the forms
prescribed by OCFS, of the certification of a newly established home or apartment as a
supervised independent living unit, and the renewal of certification or closure of an
existing supervised independent living unit.
If you have any questions, please feel free to contact your appropriate OCFS
Regional Office, Division of Child Welfare and Community Services.

Sincerely,

NEW YORK STATE
OFFICE OF CHILDREN AND FAMILY SERVICES

CONNECTIONS JOB AID
Creating, Maintaining and Closing SILP Units

Supervised Independent Living Program (SILP)

A Supervised Independent Living Program (SILP) is a program whereby children
under the supervision of an authorized child-care agency are allowed to live on their
own in the community. Such programs are intended to provide a transitional
experience for children for whom the plan of care is discharge from care to their own
responsibility. In a supervised independent living program the children will live in a
unit separate from the rest of the agency dwellings. A supervised independent living
unit may house not more than four children; children must be at least 16 years of
age and not more than 21 years of age. Before an authorized agency may operate a
SILP, the agency must have received a letter of approval to operate such a program
from the department. Each individual supervised independent living unit will require
its own approval certificate issued by the agency according to OCFS standards.
CONTENTS:
Pages 2-5……..Creating/Recording a New SILP unit in Connections
Pages 6-8…….Updating/Maintaining SILP unit information in Connections
Page 9………..Closing a SILP unit in Connections
Page 10………Approving a SILP unit in Connections
Page 11………Reassigning a SILP unit in Connections
Page 12………Requesting Technical Assistance
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NEW YORK STATE
OFFICE OF CHILDREN AND FAMILY SERVICES

RECORDING A NEW INDIVIDUAL SILP UNIT
(Supervised Independent Living Program) in CONNECTIONS
Step I: Search

1 On the CONNECTIONS Toolbar, click on the Options menu; click on FA Home;
click on F/A Home Search.

2 From the F/A Home Search window, click on the Clear button; enter the Agency
Code; in the Setting field, select Congregate; click on the Search button.

3 Review the resulting F/A Home List, verifying facility names and addresses. If the
facility is not returned in the results, click on the New button.
Step II: Demographics

1 Enter the SILP unit name in the Home Name field, using appropriate naming
protocols since there are limited spaces in the name field and to facilitate
uniformity in searches. (see :Naming Protocols for SILPs )

2 For Setting select Congregate.
3 In the Primary Address field, enter the Primary Address. Click on the Validate
button; click on Yes if the address that displays is correct. The system will
complete the CD (Community District) code for New York City.

4 Click on Save
5 If there is a different business address, Click on the Address button.
•
•
•
•

Select Business as the Type.
Type in the street address and city; do not use periods.
Click on the Validate button; click on Yes if the address that displays is
correct. The system will complete the CD (Community District) code for
New York City. Click on the Add button.
Click on the OK button.

6 In the Phone field, enter the Primary Phone number ( no spaces or hyphens)
7 If there are other known phone, fax, etc. numbers, click on the Phone button.
•
•
•

Select the Type.
Type in the phone, fax, etc. number (no spaces or hyphens).
Click on the Add button. Click on the OK button.

8 Click on the Resource… button in the Home Demographics - New window.
•
•
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On the Resource Search Criteria window, select Agency in the Resource
Type field; select Agency from the Resource Type field, type the first
few letters into the Resource Name field. Click on the Search button.
On the Resource List, select the agency and click on the OK button.
The Home Demographics - New window displays with the agency name.
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Step III: Assign

1 Click on the File drop-down menu and select Save and Assign.
2 In the Assign window, click on your name; if appropriate, click on Primary.
3 To assign additional staff with responsibility for the facility, click on the Options
menu and select Staff Search. Enter the person’s name and click on the Search
button.

4 Select the individual’s name and click on the OK button. From the Assign
window, select Primary or Secondary as appropriate.

5 Click on the Save button. Close or cancel the windows, as appropriate.
Step IV: Obtain the Resource ID (RID) Number

1 On the CONNECTIONS Toolbar, click on the WORK button.
2 Select the new SILP unit and click on the Tasks… button.
3 Select the Non-licensing Information task and click on the Detail… button.
4 View the RID number on the blue bar. Write down the number.
5 Cancel out of the Home Demographics window.
Step V: Maintain Licensing Information

1 On the CONNECTIONS Toolbar, click on the WORK button.
2 Select the new SILP unit and click on the Tasks… button.
3 Select the Maintain Licensing Information task and click on the New button.
The F/A Home License window displays.

4 Click on the drop-down arrow for the Facility Type field and select Supervised
Independent Living Program.

5 Click on the drop-down arrow for the Status field and select Applicant.
6 Enter the appropriate age ranges for male and female. The youngest minimum
age that can be recorded in CONNECTIONS is 1 month.

7 Enter the SILP capacity; the field below auto-fills.
8 Double-click the appropriate Program Type Supervised Independent Living
(SILP) Congregate Care Only. Click on the Save button.
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Step VI: Obtain the Vendor ID (VID) Number

1 Obtain a Vendor ID from the list of SILP Unit Vendor Ids sent to your agency by
OCFS.

2 Select Maintain Non-Licensing Information on the Task List. (To get the Task
List, click on the WORK button on the CONNECTIONS Toolbar, select the SILP
unit and click on Tasks…) Click on the Detail… button.

3 If the Primary and Business Address are the same, enter the Vendor ID on the
Home Demographics window, Click Validate , say “Yes” to accept validated
address.

4 Click on the Save button. CONNECTIONS will verify the VID.
5 If the Primary and Business Address are different, Click on the Address button.
Click on the Business address to display the information in the detail section of
the window.

6 Record the Vendor ID into the VID field. Verify that you have entered it correctly.
Click on the Validate button.

7 Click on the Yes button to accept validated address; click on the Modify button.
Click on the OK button.

8 In the Home Demographics window, click on the Save button. CONNECTIONS
will verify the VID.
Step VII: Submitting the SILP unit for Approval

1 Return to the Task List and select Maintain Licensing Information. Click on the
Detail… button.

2 On the F/A Home License window, select Pending Acceptance in the Status
field.

3 Click on the File menu and select Save and Submit.
4 The To Do detail window appears, Click Save.
Step VIII: Approving the SILP unit
1. Approver clicks on To Do Icon on tool bar and selects appropriate Task To Do.
2. Click on Navigate. Click on Cancel.
3. In the Approval Status window, Click on the approval in the middle of the screen.
Click on the Approve button. Click on the No button for another approver. Click
on the Save button.
4. Click on Close.
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Naming Protocols for SILP units
In order to preserve standardized data formatting and facilitate searches, follow these
naming protocols when recording information about Individual SILP units in
CONNECTIONS.
Instead of…

Use…

And

&

ACS-NY

ACS

Association

Assn

Catholic Charities

Cath Char

Children

Chn

Children’s

Chns

Community

Comm

Department

Dept

Department of Social Services

DSS

Family

Fam

Long Island

Long Is

Mother child

Mo Ch

New York

NY

New York City

NYC

Program

Pgm

Supervised Independent Living Program

SILP

Staten Island

Staten Is

Saint

St

Services

Svcs

United Cerebral Palsy Association

UCPS

’ (apostrophe) , (comma) . (period) / (slash)

e.g., St Vincents

Initial “A” or “The”

e.g., The New York Times
becomes New York Times

County

e.g., Orange County DSS becomes Orange DSS

Of
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e.g., Catholic Charities of Syracuse becomes Cath
Char Syracuse
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NEW YORK STATE
OFFICE OF CHILDREN AND FAMILY SERVICES

UPDATING SILP UNIT INFORMATION
Maintaining Licensing Information
Licensing information includes facility type, program type, ages, sex, and bed capacity. This
information is recorded in the Home License window. Supervisory approval is required for
these changes.

1
2
3
4
5
6
7

Click on the WORK button on the CONNECTIONS Toolbar.
Click on the SILP unit to select it.
Click on the Tasks… button.
Select the Maintain Licensing Information task.
Click on the Detail… button.
Make the appropriate changes (e.g., bed capacity, ages, program).
Click on the drop-down arrow for the Status field and select Pending
Acceptance.

8 Click on the File menu and select Save and Submit.
9 A Supervisor approves the changes for Maintain Licensing information.
Maintaining Non-Licensing Information
Non-licensing information includes address and phone number. This information is recorded
and changed in the Home Demographics window. Supervisory approval is not needed for
these changes.

1
2
3
4
5

Click on the WORK button on the CONNECTIONS Toolbar.
Click on the facility to select it.
Click on the Tasks… button.
Click on the Maintain Non-Licensing Information task.
Click on the Detail… button.

To change the SILP unit’s Primary address:

1 In the Primary Address section on the Home Demographics window, make the
appropriate changes to the fields.

2 When you are finished making changes, click on the Validate button.
3 If the address in message is correct, click on the Yes button; otherwise click on
the No button.

4 Click on the Save button
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To change the SILP unit’s Business address:

1 Click on the Address… button on the Home Demographics window.
2 In the list section at the top of the Resource Address Detail window, select the
Business address to be changed.
The selected address displays in the Address Information section at the bottom
of the window.

3 Make the appropriate changes in these fields.
4 When you are finished making the changes, click on the Validate button.
5 If the address in the message is correct, click on the Yes button; otherwise click
on the No button.

6 Click on the Modify button.
The new address displays in the list section of the window.

7 Only one address can be changed at a time. Repeat the process if both
addresses need to be changed.

8 Click on the OK button to save the changes.
9 Click on the Cancel button to close the Home Demographics window.
10 Click on the Cancel button to close the Task List.
To change the SILP unit’s primary phone number:

1 In the Primary Phone section on the Home Demographics window, make
appropriate changes to the fields.

2 Click on the Save button.
To change the SILP unit’s Business phone number:

1 Click on the Phone… button on the Home Demographics window.
2 Select the Primary or Business phone number to be changed in the list section at
the top of the window.
The phone number displays in the detail section at the bottom of the window.

3 Make any necessary changes in these fields.
4 Click on the Modify button.
The new phone number displays in the list section at the top of the window.
Only one phone number can be changed at a time. Repeat the process if multiple
phone numbers need to be changed.

5 Click on the OK button to save the changes.
6 Click on the Save button to close the Home Demographics window.
7 Click on the Close button to close the Task List.

10/10/2008
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NEW YORK STATE
OFFICE OF CHILDREN AND FAMILY SERVICES

CLOSING AN INDIVIDUAL SILP UNIT
Supervisory Approval is necessary for SILP unit closures.

1 Click on the WORK button on the CONNECTIONS Toolbar
2 Click on the SILP unit to select it.
3 Click on the Tasks… button.
4 Select the Close Home task.
5 Click on the New button.
6 Click on the drop-down arrow for the Closure Reason field and select the
appropriate closure reason.

7 Click on the drop-down arrow for the Closure Type field and select either
Involuntary Closure or Voluntary Closure. Usually the selection is Voluntary
Closure.

8 Click on the drop-down arrow for the Recommend Re-opening field and select
either Recommend or Do Not Recommend. Usually the selection is Recommend.

9 Click on the File drop-down menu and select Save and Submit.
10

Supervisor Approves the SILP unit closure from To Dos.

11

Voluntary Agency notifies the Regional Office of SILP unit closures

10/10/2008
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NEW YORK STATE
OFFICE OF CHILDREN AND FAMILY SERVICES

APPROVING A SILP UNIT
1

On the Task List, click on the Options menu and select Case To-Do’s…
or Click on the To Do Icon on the Connections toolbar

2

Select the Task To-Do for the SILP approval.

3

Click on the Navigate… button.

4

Click on the Cancel button in the F/A Home License window..

5

Click on the approval item in the center of the Approval Status window with your
name in the Approver column.

6

Click on the Approve button.
The following message displays:
“Approval completion will freeze events. Do you wish to add another approver?”

7

Click on the No button.

8

Click on the Save button..

9

To close the Case To-Do List, click on the Close button.

10/10/2008
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NEW YORK STATE
OFFICE OF CHILDREN AND FAMILY SERVICES

REASSIGNING A SILP UNIT
1

Click on the SILP unit in workload

2

Click Assign button

3

If the name of the worker appears at the top of the screen, select it.

4

If the name of the worker does not appear at the top of the screen, Select Options,
Staff Search Criteria

5

Enter the name of the staff member in the Name fields, click Search

6

Highlight the name from the resulting list. Click OK.

7

On the Assign window, select the name at the top of the screen if not already
selected, select Primary or Secondary as needed. If you are reassigning Primary,
you will get a pop up message, say “Yes”

8

Click Save

10/10/2008
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NEW YORK STATE
OFFICE OF CHILDREN AND FAMILY SERVICES

REQUESTING TECHNICAL ASSISTANCE
Help Desk
If an error message displays on a worker’s computer screen during an attempt to sign on to
CONNECTIONS or while working in CONNECTIONS, or the worker needs help with
CONNECTIONS step by step instructions, report the problem to the NYS OFT Enterprise
Help Desk in order to correct the problem.
Before phoning the Help Desk, do the following:
• If possible, keep the error message on the screen (or write it down) so that you
can describe the specific error or difficulty to the Help Desk.

•

Call the Help Desk at 1-800-697-1323. If the Help Desk is not able to solve the
problem immediately, they will assign a ticket number for the problem.

•

Write down the ticket number. This ticket number will be needed for reference in
any subsequent calls concerning the problem.

10/10/2008
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NEW YORK STATE
OFFICE OF CHILDREN AND FAMILY SERVICES

TYPE OF FACILITY SUPERVISED INDEPENDENT LIVING PROGRAM (SILP):

Voluntary Agency Application for Supervised
Independent Living Program (SILP)
INSTRUCTION: This application must be completed by a responsible agent of the
Facility (Officer of the Board of Trustees, Administrator, etc.). Complete ALL items on
this form. Attach additional sheets as necessary. MAIL completed form within 5
business days to the appropriate Regional Office of the NYS Office of Children and
Family Services.
(Print or Type)

NYS OCFS CENTRAL OFFICE USE
EFFECTIVE DATE

APPLICATION TYPE
New

EXPIRATION DATE

Renewal

APPLICANT (Name and Address of Agency, Association, Corporation or Other Legal Entity Operating the Facility)

Not for Profit
Public Agency
Other Specify)

FACILITY (Name and Address including Zip Code)

TYPE:

RESIDENT CAP:

REGULAR
ESTIMATED CAPITAL COST

MOTHER/CHILD

FINANCIAL RESOURCES AS OF LAST FISCAL YEAR
ASSETS
Cash and Receivable

Construction or Purchase (incl. land)

$

Equipment

$

Fixed Assets

$

Other (specify)

$

Other (Specify)

$

TOTAL

$

$

TOTAL ASSETS
LIABILITIES
Current

Indicate how total will be provided

SOURCE

AMOUNT

$

Long Term

$

Other (Specify)

$

$
$

IF LEASED FACILITY
NAME OF OWNER OF LAND AND BUILDING

TERMS OF LEASE

$

NET WORTH (Assets-Liab.)

$

$

$

Government Fees

$

Other (Specify)

$

Amount of rental and
other cost pursuant
to lease.

*

TOTAL LIABILITIES

SOURCES OF REVENUE (Current Year)
Resident Fees

$

$

TOTAL REVENUE

$

TOTAL EXPENDITURES

$

CERTIFICATION: I certify that the statements in this application and all
attachments are correct to the best of my knowledge.

* Copy of lease to be submitted upon request.

ATTACHMENTS
Have you attached a Plan and Description of Staff Positions including
Duties and qualifications (Indicate vacant positions)

NAME

PHONE:

If Applicant is a Corporation, have you attached a list of names,
addresses, and occupations of the Board of Directors.

TITLE

DATE:

Have you attached a brief physical description of the Facility, including
land, all buildings, number of floors, and construction

SIGNATURE

X

NYS OCFS REGIONAL OFFICE USE ONLY
RECOMMENDATION:
APPROVE
DENY

RESTRICTIONS:

Evaluation Dates
LATEST:

REGIONAL OFFICE ACTION BY:

NEXT:

X

DATE:

CENTRAL OFFICE ENDORSEMENT:

DATE:

OCFS-2657 (8/2008)

NEW YORK STATE
OFFICE OF CHILDREN AND FAMILY SERVICES

NOTICE OF SILP CLOSING, TRANSFERRING, RECERTIFICATION AND OPENING
Please note: Information listed below needs to be forwarded to the appropriate NYS Office of children and Family Services Regional
Office within 10 days of listed action.
TO:

FROM: Agency :
SILP:
Contact:
Address:
RID#:
VID #:

RE:

DATE COMPLETED AND SENT:

SILP Opening
SILP Transferring
SILP Recertification
SILP Closing
OLD AGENCY

NEW AGENCY (transfers only)

Agency Name:

Agency Name:

Agency ID:

Agency ID:

Contact Person:

Contact Person:

Street Address:

Street Address:

City, State, Zip:

City, State, Zip:

Phone:

Phone:

Fax:

Fax:

E-Mail:

E-Mail:

Date of, Opening, Transfer, Recertification or Closing:

Changes made in CONNECTIONS:

Specify the contact person and phone number if different from
agency/facility above:
Contact Person:
Phone Number:
INFORMATION ON CLOSING

ADDITIONAL COMMENTS

OCFS-4883 (8/2008)

NEW YORK STATE
OFFICE OF CHILDREN AND FAMILY SERVICES

AGENCY CHECKLIST FOR SILP OPERATION
All items on this checklist must be completed by a responsible agent of the facility (officer of the Board of
Trustees, Administrator, etc). Please complete all requirements listed below and mail to the appropriate
Regional Office of the New York State Office of Children and Family Services.
Authorized agencies, regardless of whether they are initiating a SILP program or currently operating an
OCFS certified supervised independent living unit, will be required to complete an application and provide
the following information:
A description of the need for the program, type of SILP program, and a list of the social services districts
interested in using the program, including letters of support from all districts that intend to use the
proposed program;
A description of the services that will be provided, including a plan setting forth how the services will be
provided;
The population to be served;
Proposed staffing, including the proposed staff to youth ratio for the program and the procedures for
obtaining background checks on prospective employees, volunteers or consultants;
A description of where units will be located and the Agency’s process for SILP certification.
A description describing how the Agency will interact with localities regarding annual inspections.
A certification that all supervised independent living units will be operated in compliance with
18 NYCRR Part 449; and
Any other information required by OCFS.

"The agency hereby certifies that it will administer its supervised independent living program and will certify
and supervise supervised independent living units in a manner consistent with applicable statutes and
regulations, including, but not limited to, those set forth in 18 NYCRR Parts 441 and 449."

CHIEF OPERATING OFFICER OR DESIGNEE

DATE

OCFS-4884 (8/2008)

NEW YORK STATE
OFFICE OF CHILDREN AND FAMILY SERVICES

SUPERVISED INDEPENDENT LIVING PROGRAMS
FIRE SAFETY INSPECTION GUIDELINES PER NYS OCFS REGULATION 449
NAME OF AGENCY:

FACILITY ADDRESS:

DATE OF INSPECTION:

INSPECTION CONDUCTED BY:

TYPE OF HEATING SYSTEM:

Electric

Gas

Oil

Other (specify)

TESTING & MAINTENANCE: ANNUALLY OCFS SECTION 449.4 (B)(4)(xviii)
FIRE PROTECTION SYSTEM
OCFS reg. 449
Date Inspected:

Compliant

Non-Compliant

Compliant

Non-Compliant

449.4(b)(4)&(iv)

PORTABLE FIRE EXTINGUISHERS
OCFS reg. 449
Date Inspected:

449.4(b)(4)(vii)

FIRE ALARM/DETECTION SYSTEM – NOTIFICATION DEVICES – CONNECTION TO CENTRAL STATION
OCFS reg. 449
Compliant
Non-Compliant
Date Inspected:

449.4(b)(4)&(iv)

HEATING PLANT
Conducted by:

OCFS reg. 449

Date Inspected:

449.4(b)(4)(xv)

CHIMNEY AND FIREPLACE INSPECTED ANNUALLY
Conducted by:
OCFS reg. 449
Date Last Inspected:

Compliant

Non-Compliant

Compliant

Non-Compliant

Compliant

Non-Compliant

449.4(b)(4)(i)

ELEVATOR INSPECTION (WHERE APPLICABLE)
Conducted by:
OCFS reg. 449
Date Last Inspected:

Non-Compliant

449.4(b)(4)(xx)

PRIVATE WATER SUPPLY ANNUAL REPORT (WHERE APPLICABLE)
Conducted by:
OCFS reg. 449
Date Last Inspected:

Compliant

449.4(b)(xiv)
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LOCAL FIRE AUTHORITY OR INSURANCE CARRIER INSPECTION
Conducted by:
OCFS reg. 449
Date Last Inspected:

Non-Compliant

Compliant

Non-Compliant

449.4 (b)(4)(xviii)

EMERGENCY GENERATOR RUN TEST RECORDS
Tested Organization:
OCFS reg. 449
Date of Last Run:

Compliant

449.4 (b)(4)(xiv)

SILP REQUIREMENTS PER OCFS SECTION 449.4 (b)(4)(ix)
No
Wood Frame Construction (Type V):
No

Yes
Yes

No bed in unfinished attic,
basement, stair hall, or storage room:

No

Yes

No children above second floor:

No

Yes

Children of limited mobility in a Type V wood
frame building protected by a sprinkler system:

No

Yes

Children of limited mobility in a Type V wood
frame not permitted above the first floor:

No

Yes

First floor is handicap accessible:

No

Yes

(If Yes, review items below)

FIRE PREVENTION AND MAINTENANCE
FIRE DEPT. & EMERGENCY SERVICE ACCESS
OCFS reg. 449
ITEM# TOPIC
Structure accessible for fire equipment 449.4(b)(4)(i)
1
2

Fire lanes clear and unobstructed

449.4(b)(4)(i)

3

Nothing obstructing the use of fire
hydrants or fire dept. connections

449.4(b)(4)(i)

Compliant

Non-Compliant

EXTERIOR PROTECTION
ITEM# TOPIC
Combustible waste and refuse which
4
constitute a fire hazard is removed

OCFS reg. 449
449.4(b)(4)(v)

Compliant

Non-Compliant

MEANS OF EGRESS
ITEM# TOPIC
There is a minimum of two means of
5
egress provided from each floor that
are accessible to children

OCFS reg. 449
449.4(b)(4)(viii)

Compliant

Non-Compliant

6

The window opening is at least 24
inches high and 20 inches wide to
qualify as a means of egress

449.4(b)(4)(viii)

7

The bottom of the window is no higher
than 3 feet 8 inches above the floor or
an accessible access been provided
(steps or furniture affixed in place
provided)

449.4(b)(4)(viii)
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MEANS OF EGRESS
ITEM# TOPIC
For windows used as a means of
8
egress, a platform stair permanently
affixed to the building and leading to
the ground.

OCFS reg. 449
449.4(b)(4)(viii)

9

There is no storage in stairways or
corridors or aisles.

449.4(b)(4)(x)

10

All exits doors and means of egress,
halls, stairs, are kept clean and free
from obstructions and ready at all
times for immediate use.

449.4(b)(4)(x)

11

Exits are provided, and adequately
illuminated. Emergency lighting
provided (battery or emergency
generator). Interior decorations do
not obscure exit doors or exit signs

449.4(b)(4)(x)

12

The SILP living unit is provided with
emergency lights(flashlights, battery
operated lanterns) and are in good
working condition

449.4(b)(4)(xi)

13

If provided, smoke and fire doors
(including all hardware) are functional
for proper operation. Automatic holdopen devices are installed and
maintained on smoke / fire doors (No
obstructions).

449.4(b)(4)(x)

14

A plan for evacuation posted in a
conspicuous place on each floor level
of the living unit.

449.4(b)(4)(xii)

EQUIPMENT AND SYSTEMS
ITEM# TOPIC
Heating equipment is maintained
15
within a one hour fire rated enclosure

OCFS reg. 449
449.4(b)(4)(ii)

16

Heating systems are maintained as
not to create a hazard

449.4(b)(4)(xv)

17

Heating plants are protected from
tampering by children

449.4(b)(4)(xv)

18

Safety devices are not rendered
inoperable (shut off valves)

449.4(b)(4)(xv)

19

There are no obstructions to fuel gas
or oil burning equipment

449.4(b)(4)(xv)

20

Chimneys, flue pipes and gas vents
are maintained properly

449.4(b)(4)(xx)

21

Combustible materials not stored
within enclosure containing a heat
producing device

449.4(b)(4)(xv)

3

Compliant

Non-Compliant

Compliant

Non-Compliant
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KITCHEN EQUIPMENT
OCFS reg. 449
ITEM# TOPIC
The exhaust systems are maintained in 449.4(b)(4)(iv)
22
safe operating condition. Hoods and
ducts are maintained free of grease
Kitchen appliances are kept in clean,
449.4(b)(3)
23
sanitary condition and in good working
condition. (refrigerator /freezer, stove,
oven, and microwave oven)
ELECTRICAL SYSTEMS
OCFS reg. 449
ITEM# TOPIC
Protective caps, covers, or
449.4(b)(15)(vi)
24
permanently installed obstruction
devices on all electrical outlets
accessible to children must be present
25

No extension cords in use

449.4(b)(4)(v)(m)

26

If in use, the multi-outlet power strip
type is approved in writing by the
authorized agency

449.4(b)(4)(v)(m)

PLUMBING SYSTEM
ITEM# TOPIC
Adequate bathing, toilet and lavatory
27
kept in sanitary condition
The plumbing and sewer in good
28
working condition
ELEVATOR EQUIPMENT
ITEM# TOPIC
Elevator hoist-ways and pits are
29
maintained free of rubbish and debris
Elevator machine rooms are not used
30
for storage of materials unnecessary
for maintenance of equipment
Elevator are properly lighted and have
31
alternate power

OCFS reg. 449
449.4(b)(8)

Compliant

Non-Compliant

Compliant

Non-Compliant

Compliant

Non-Compliant

Compliant

Non-Compliant

Compliant

Non-Compliant

449.4(b)(15)(v)(h)

OCFS reg. 449
449.4 (b)(4)(i)
449.4 (b)(4)(i)

449.4 (b)(4)(i)

FIRE DETECTION & PROTECTION EQUIPMENT
OCFS reg. 449
ITEM# TOPIC
449.4(b)(4)
A supervised independent living unit
32
must be protected by a fire detection
system, or a sprinkler system, as
defined in section 441.2 of this Title, or
a smoke detection system or individual
smoke detectors as required by
applicable local codes and the New
York State Uniform Fire Prevention and
Building Code. example: Located as
follows: at a minimum there must be a
smoke detector in each room of a SILP
living unit
(a) Smoke detection at the top of
each stairway, in each hallway,
(b) Heat detectors in the kitchen,
heating equipment room and attics

4
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FIRE DETECTION & PROTECTION EQUIPMENT
OCFS reg. 449
ITEM#
TOPIC
All Detectors and Manual fire
449.4 (b)(4)(iv)
33
alarm stations are visible,
unobstructed, and maintained.
34

Instructions for alarm boxes
conspicuously posted.

449.4 (b)(4)(iv)

35

If fire alarm system is not
connected to Central Station of
Fire Dept., Local Alarm Only – Call
911 signs must be posted.

449.4 (b)(4)(iv)

36

Fire detection system or sprinkler
system is provided in unsupervised
spaces containing fire hazardous
materials and 1-hour fire rated
separation. Area of fire hazard
means the following but limited to
heating equipment room;
woodworking shop, paints and/ or
other combustible or flammable
materials or liquids.
If a sprinkler system is provided,
the fire dept. connections are
clearly identified and accessible

449.4 (b)(4)(ii)

38

Sprinkler control valves are
unobstructed and accessible.

449.4 (b)(4)(iv)

39

All system valves and piping in
good working condition- no leaks
visible
Material storage is kept clear so
that it does not interfere with
sprinkler head water discharge
(18" clearance)
Standpipe hose is properly stored,
maintained and tested.

449.4 (b)(4)(iv

Standpipe hose stations are
conspicuously identified

449.4 (b)(4)(iv)

37

40

41
42

PORTABLE FIRE EXTINGUISHERS
ITEM#
TOPIC
Minimum of one extinguisher for
43
each floor, and additionally one for
designated locations: kitchen,
laundry and outside heating
equipment room
Extinguisher hung between 2 and
44
4 ½ feet above floor
45

The Extinguishers are maintained
properly (clear and unobstructed,
monthly inspections checks
conducted, easily identified,
security seal and pin secure,
extinguisher fully charged and in
working condition)

Compliant

Non-Compliant

Compliant

Non-Compliant

449.4 (b)(4)(iv)

449.4 (b)(4)(iv)

449.4 (b)(4)(iv)

OCFS reg. 449
449.4 (b)(4)(vii)

449.4 (b)(4)(vii)
449.4 (b)(4)(vii)

5
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HAZARDOUS MATERIALS
ITEM#
TOPIC
The flammable materials
46
necessary for operation and
maintenance of the SILP is stored
in approved, self-closing cans.-

OCFS reg. 449
449.4(b)4(iii)

47

Flammable materials are not
stored the SILP living unit

449.4(b)4(iii)

48

All cleaning material, detergents,
aerosol cans, beauty aids, and
poisonous or toxic materials must
be stored in their original
containers, and must be used in
such a way that they will not
contaminate play surfaces, food
and food preparation areas, or
constitute a hazard to children, and
other such materials must be kept
in a place inaccessible to children

449.4(b)(15)(vii)

FIRE SAFETY PRACTICE and TRAINING
ITEM#
TOPIC
Suitable precautions are taken to
49
eliminate all conditions, which may
constitute or create a fire, health
and/or safety hazard (clothes,
dryer lint, etc.)
There is at least one single line
50
non-coin operated telephone is
immediately available for general &
emergency use (emergency
telephone numbers for fire, police,
medical assistance must be posed
on an adjacent to telephones)

OCFS reg. 449
449.4(b)(4)(v)

449.4(b)(4)(xvii)

51

All Fires are reported to OCFS
within 24 hours after any fire, with
a written report within 10 days.

449.4(b)(4)(xix)

52

The staff and parenting youth
maintain a current first-aid and
CPR training certification

449.4(c)(2)(i)

53

Staff and youth are instructed in
how to evacuate the building in
which the SILP unit is located

449.4(b)(4)(xiii)

54

The evacuation plans are reviewed
quarterly with the youth after
placement

449.4(b)(4)(xiii)

55

New admitted youth, new staff,
and volunteers are instructed in
the evacuation procedure during
their orientation to SILP

449.4(b)(4)(xiii)
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Compliant

Non-Compliant

Compliant

Non-Compliant

OCFS-4884 (8/2008)

Physical Plant & Space Requirements
ITEM#
TOPIC
No peeling or damaged paint or
56
plaster is present

OCFS reg. 449
449.4(b)(15)(i)

57

If an outdoor play space available
449.4(b)(15)(ii)
for children, the equipment must be
in good working condition

58

The SILP unit clean sanitary
condition and in good repair

59

Minimum square footages for bed
449.4(b)(9)
rooms,
Single 70 Sq. Ft.
Double 70 Sq. Ft. Plus and
additional 50 Sq. Ft. with at least
two feet of space between each
bed.
All habitable rooms, except the
449.4(b)(10)
kitchen, shall be no less than seven
feet in any dimension. For rooms
with sloped ceilings, include only
the floor dimensions with a clear
ceiling height of five feet or more in
this calculation. One-third of the
minimum required floor area of
each room must have a ceiling
height of seven feet.
The kitchen has at least three feet
449.4(b)(11)
of clear passage between counter
fronts and appliances or counter
fronts walls.

60

61

449.4(b)(3)

No materials containing asbestos
are evident in any construction/
renovation or repair of an SILP that
occurred after July 1, 1993 is
prohibited.
The unit is effectively screened
against flies and other insects

449.4(b)(15)(v)(j)

64

Radiators and steam, heating
pipes in rooms occupied by
children are covered to protect
children.

449.4(b)(15)(iii)

65

All porches, decks, and stairways
have railings with a barrier to
prevent a child from falling

449.4(b)(15)(iv)

66

Adequate barriers are provided
and /or installed to prevent children
from gaining access to unsafe,
dangerous or hazardous areas or
devices Examples: fire places,
pools, hot tubs, and second floor
and above windows.

449.4(b)(15)(v)

67

All matches, lighters, medicines,
drugs, cleaning material, and
other such materials are kept in a
place inaccessible to children

449.4(b)(15)(vii)

62

63

449.4(b)(6)
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Compliant

Non-Compliant
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Physical Plant & Space Requirements - Continued
OCFS reg. 449
ITEM#
TOPIC
Hand bags, backpacks, briefcases, 449.4(b)(15)(viii)
68
plastic bags, toys and objects small
enough for children to swallow not
accessible to children.
69

Connections for gas appliances are 449.4(b)(4)(v)(d)
per code (rubber tubing etc.)

69

Connections for gas appliances are 449.4(b)(4)(v)(d)
per code (rubber tubing etc.)

70

Combustible or flammable
449.4(b)(4)(v)(e)
containers used for ashes are not
used
There is no evidence of an
449.4(b)(4)(v)(f)
accumulation of combustible or
flammable materials in any part of
the unit, except in approved storage

71

72

73

74

75

76

77

There is no evidence of portable
electric space heaters or selfcontained fuel-burning space
There is no evidence of the use of
fuel burning or electric (hot plates
are prohibited)
Unless approved in writing by the
authorized agency, there is no
evidence of solid-fuel-burning and
Unless approved in writing by the
authorized agency, there is no
evidence of extension cords
There is no evidence of the use of
furniture, toys, and any part of the
unit/building containing lead based
Any other condition deemed
hazardous by OCFS and the
authorized agency.

449.4(b)(4)(v)(a)

449.4(b)(4)(v)(c)

449.4(b)(4)(v)(b)

449.4(b)(4)(v)(m)

449.4(b)(15)(v)(l)

449.4(b)(4)(v)(n)

Additional Comments:
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Compliant

Non-Compliant

